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Multiple Target Features
Using CodeWarrior 
John Winters

1.   Abstract
One of the benefits of the Software Development Kit (SDK)
for Motorola’s Digital Signal Processor (DSP) family of
processors is its flexibility. The SDK provides Stationery
(templates) to address External RAM and Flash. However,
templates to address new product hardware may be required
and can be developed using tools in CodeWarrior. This
document details the steps required to create a new build
target.

There are two meanings for the term “target”, as used by
CodeWarrior:

A build target is a particular collection of settings and files
that determines the content of your code and the process in
which the code is compiled and linked into the final output.

A platform target is the processor or operating system for
which you are writing code, represented as the choice of
linker specified in the build target settings panel.

In this document, the term “target” refers to a build target.

2.   Introduction
This application note details how to create the new Stationery
and build target for a prototype product configuration,
possibly differing in software, hardware, or both, from the
Flash and the External RAM build targets supplied with
standard SDK build Stationery.  The new build target, proto,
is in addition to the existing build targets defined in the
Stationery.  

These are the tasks required to add multiple varied build
targets:

1. The Stationery must be expanded 
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2 Multiple Target Features Using CodeWarrior �

Expand Stationery

2. The new build target is added

3. The settings of the new build target are edited to differentiate it from the other build 
targets’settings, so it evolves separately as development of the prototype progresses

4. The new Stationery is related to the project file structure 

5. The BuildAll target is updated

A step-by-step, illustrated procedure follows.

Prior to undertaking this procedure, back up the contents of the directory:

C:\Program Files\Metrowerks\CodeWarrior\Stationery\Embedded SDK\dsp56805evm\nos

After completion of the procedure, back up the new contents in a separate place so that in the event of
a subsequent installation of Metrowerks or the SDK, there is no possibility of lost work.

3.   Expand Stationery
Project Stationery is a write-protected model project copied into a new project area.  The Stationery is
supplied with the SDK, but located in the Metrowerks’ program area.  When a new project is created
with CodeWarrior, a prompt to select Stationery automatically appears.

In this first section, the Stationery supplied with SDK in the Metrowerks’ directories is expanded for
the new build target, proto.  In the following, … nos stands for:

C:\Program Files\Metrowerks\CodeWarrior\Stationery\Embedded SDK\dsp56805evm\nos

This file address will differ if CodeWarrior is not installed in the default location.

The new Stationery is named ER_and_Fl_and_proto_Application, and is designed to support three
build targets:

• ER = External RAM

• Fl = Flash

• Proto = Prototype System

w Copy the folder:

   ..nos\ExtRam_and_Flash_Application

to:

   ..nos\ER_and_Fl_and_proto_Application

Note: After copying the folder, make the new folder and its contents read/write access using a dos 
window and the attrib command, or ask your system administrator for assistance.  These new 
files are modified to suit the prototype needs. Figure 1 illustrates the new folder, 
ER_and_FI_and_proto_Application.
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Add a New Build Target

� Multiple Target Features Using CodeWarrior 3

Figure 1. ER_and_FI_and_proto_Application

w Copy the folder:

..nos\ER_and_Fl_and_proto_Application\configextram 

to:

..nos\ER_and_Fl_and_proto_Application\configproto

This procedure provides the proto application an identical configuration to the External RAM build
target settings.  The new proto build target settings will be changed as required in the configproto
folder. Figure 2 illustrates the new folder, configproto. The Stationery has been expanded with
another available selection.

Figure 2. configproto

4.   Add a New Build Target

Using the newly-defined Stationery, a new build target will be delineated for the prototype system.
Initially, this build target will be similar to the External RAM build target.

    

  

F
re

e
sc

a
le

 S
e

m
ic

o
n

d
u

c
to

r,
 I

   
   

   
   

   
   

   
   

   
   

   
   

   
   

   
  

Freescale Semiconductor, Inc.

For More Information On This Product,
  Go to: www.freescale.com

n
c

..
.

ARCHIVED BY FREESCALE SEMICONDUCTOR, INC. 2005
A

R
C

H
IV

E
D

 B
Y

 F
R

E
E

S
C

A
L

E
 S

E
M

IC
O

N
D

U
C

TO
R

, I
N

C
. 2

00
5



4 Multiple Target Features Using CodeWarrior �

Add a New Build Target

w Create a folder on the desktop to house this demonstration project creation and name it an_app

w Using the Windows Start button, launch CodeWarrior through the Motorola Embedded SDK tree 

w In Metrowerks’ CodeWarrior program, click New on the File menu, as shown in Figure 3

Figure 3. New Project File

Once the New selection is made, CodeWarrior will offer a choice of Stationery, overviewed in
Figure 4.

Figure 4. CodeWarrior Stationary Categories

w In the New screen, click Embedded SDK Stationery 

w Click the Set button to browse the desktop 

w Locate the an_app folder, Figure 5, which will house the new project
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Add a New Build Target

� Multiple Target Features Using CodeWarrior 5

Figure 5. Name the New Project

w Name the project file one, as shown in Figure 5

w Click the Open button; the file name becomes the project name. See Figure 6.

Figure 6. Project Name Appears

The project name and its location will now appear as illustrated in Figure 6.

w Click OK; the new “project window” appears

w Click DSP805EVM at the plus sign

w Click nos at the plus sign, revealing choices for Stationery, as illustrated in Figure 7
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6 Multiple Target Features Using CodeWarrior �

Add a New Build Target

Figure 7. Select Stationery Created Earlier in the Paper

w Click the newly-created Stationery, illustrated in Figure 7

w Click OK in the New Project screen. A new project window, one.mcp, will appear, displaying one of
the selected build targets; in this case, External RAM. See Figure 8.

Figure 8. one.mcp Project Window
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Add a New Build Target

� Multiple Target Features Using CodeWarrior 7

To see other possible build targets defined:

w Open the Target pop-up menu, as illustrated in Figure 9

Note: There is no build target yet defined for proto; other build targets are Flash and BuildAll.

Figure 9. Target Pop-Up Menu

w BuildAll creates both Flash and External RAM. A new build target called proto will be added next. 
Then BuildAll will be modified to build the proto build target.
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8 Multiple Target Features Using CodeWarrior �

Add a New Build Target

To generate the proto build target, follow the procedure in the CodeWarrior Help Section “Create
Targets”. To do this:

w Click the Targets tab of the one.mcp screen; see Figure 10

Figure 10. Targets Tab Contents

The build targets shown are:

• External RAM

• Flash

• BuildAll
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Add a New Build Target

� Multiple Target Features Using CodeWarrior 9

Targets will appear toward the right in the screen. Under the CodeWarrior Project pull-down menu,

w Click Create New Target; see Figure 11 

Figure 11. Create a New Build Target
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10 Multiple Target Features Using CodeWarrior �

Add a New Build Target

When a new build target is requested, CodeWarrior provides a pop-up box, called New Target, with a
field for the build target’s name. Figure 12 illustrates an empty target, currently selected, and an
existing target, External RAM, to be cloned. New projects often evolve from existing projects. 

Figure 12. New Target Pop-Up Box
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Add a New Build Target

� Multiple Target Features Using CodeWarrior 11

To clone a new target from the External RAM target, type the new build target’s name, proto, in the
Name for new target field in the New Target box and click Clone existing target. See Figure 13. The
proto target will initially have all the settings and features of the External RAM target.

Figure 13. Naming a New Target and Cloning an Existing Target

A new build target choice, proto, will appear in the one.mcp screen; refer to Figure 14. Of course, this
build target is not actually new, because it is a clone of the External RAM build target. To insure the
build target will run on the prototype board, customize the new build target clone to use the prototype
configuration. 

Figure 14. A New Target, proto
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12 Multiple Target Features Using CodeWarrior �

Edit Prototype Build Target Settings

5.   Edit Prototype Build Target Settings
To edit the settings for the new build target, proto: 

w In the one.mcp screen, select proto under Targets

w A new choice, proto Settings, appears in the Metrowerks’ CodeWarrior Edit menu, as shown in 
Figure 15; this choice allows edits of settings for the new proto build target

Note: This is an important step, because it allows proto to differ from the clone that produced it, 
External RAM. If no changes were made to proto’s settings, proto would create the same build 
target from the same files as the External RAM build target.

w In the Edit menu of CodeWarrior, click proto Settings... as illustrated in Figure 15

Figure 15. Click proto Settings

Note: The new choice in the Edit menu, proto Settings, is provided because proto is being targeted in 
the one.mcp screen. The Edit menu would have provided a different choice if another build 
target were selected; e.g., Flash Settings had the Flash build target been selected.
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Edit Prototype Build Target Settings

� Multiple Target Features Using CodeWarrior 13

w When the box proto Settings appears, shown in Figure 16, select Target Settings from the Target 
 Settings Panels and click the desired access path

Figure 16. proto Settings Box
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14 Multiple Target Features Using CodeWarrior �

Edit Prototype Build Target Settings

Use the new configuration files from the new portion of the project Stationery created earlier for the
prototype build target.  Refer to Figure 16. 

Note: The selected new build target is indicated in the one.mcp screen as proto.  This agrees with the 
left side of the screen, indicating operation on the proto build target. 

As shown in Figure 17, the Add... button is located at the bottom of the proto Settings screen.

w Click Add... to add the configproto access path relative to the project. The prototype
configuration is the local project.  

These files may be modified to fit the prototype, after the prototype build target is tested in the
External RAM of the EVM. 

w Add the config files to this target so it can use them instead of other versions of the files with the 
same file name.  These configuration files are part of the Stationery and are named: 

• linker.cmd

• appconfig.c

• appconfig.h

Files must be named identically to those above in the configproto, configextram, and configflash
build directories. The files are tailored for each of the three build targets:

• proto

• extram

• flash

w Click OK in the window named Please Select an Access Path

A new directory, configproto, will appear, illustrated in Figure 17.

Figure 17. configproto Access Path

wFind {Project}configproto, the last directory under User Paths in the proto Settings window shown
in Figure 18
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Edit Prototype Build Target Settings

� Multiple Target Features Using CodeWarrior 15

Figure 18. {Project} configproto Before Move
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16 Multiple Target Features Using CodeWarrior �

Edit Prototype Build Target Settings

w Drag and drop the {Project}configproto to the top of the list under Access Path, illustrated in 
Figure 19.

Figure 19. {Project} configproto After Move
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Edit Prototype Build Target Settings

� Multiple Target Features Using CodeWarrior 17

w Click M56800 Target and overwrite the External RAM elf file name. The Output File Name, as 
shown in Figure 20, must be changed from ExtRam.elf.

Figure 20. Proto Settings Output File Name Before Name Change
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18 Multiple Target Features Using CodeWarrior �

Edit Prototype Build Target Settings

w Rename the file proto.elf; refer to Figure 21

Figure 21. proto Settings Output File Name After Name Change

w Click Save to save the settings for proto

Compare Figure 20 and Figure 21. 

The new proto target is created.
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Relate New Build Target to Project Files

� Multiple Target Features Using CodeWarrior 19

6.   Relate New Build Target to Project Files
The Files tab under the one.mcp screen now has three files and three copies of the configuration files,
instead of two.  One of the new sets is for the new target, proto.  It’s important to differentiate among
the files because they all have the same name, but without individual, specific paths. As shown in
Figure 22, it’s difficult to know where the files reside or even which file is which.

Figure 22. Undifferentiated Configuration Files

To locate files:

w Left click the Files tab at the top of the one.mcp window

w Right click the appconfig.h file with a black dot under the target column, the second column from 
the right side of the window; this is the file proto will use 
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20 Multiple Target Features Using CodeWarrior �

Relate New Build Target to Project Files

This step uses the Windows Explorer program to identify the location of the file; see Figure 23.

Figure 23. Select appconfig.h File proto Will Use
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Update the BuildAll Target to Include the New Prototype Target

� Multiple Target Features Using CodeWarrior 21

Figure 24 illustrates the full path to the sought file.

Figure 24. Path to configproto

The files appconfig.c, appconfig.h and linker.cmd are present in this folder. All files may be
customized for the prototype without affecting the other targets, External RAM or Flash.

7.   Update the BuildAll Target to Include the New Prototype 
Target

Update the BuildAll target so it will build the new proto target.  This process may be repeated for each
version of required settings on each target product.

To update the BuildAll:

w In one.mcp, click the Target tab and expand the BuildAll, which does not yet have the new target.

w To add the new proto target to the BuildAll target, simply drag it to the BuildAll target. 
Figure 26 illustrates prior to relocating the proto target file, while Figure 27 illustrates the moved 
file.
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Figure 25. Before Adding proto to BuildAll Target

Figure 26. After Adding proto to BuildAll Target

To order the files:

w Drag and drop the files, placing them in a desired order, as illustrated in Figure 27.
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Figure 27. Files Arranged in Desired Order

8.   Conclusion
A single CodeWarrior project can support a growing family of products. Project Stationery may be
enhanced and multiple additional targets may be built to support permutations of hardware and product
features within a single project.
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